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Preface 

Disclaimer 

This document is initial draft and still in reviewing phase by these parties: 

• Badan Nasional Penanggulangan Bencana (BNPB) 

• Australia-Indonesia Facility for Disaster Reduction (AIFDR-DFAT) 

• Humanitarian OpenStreetMap Team (HOT) 

All contents and materials on this document possibly changed without public notice. 

License 

 

All contents and materials on this document is licensed as Creative Commons 

Attribution Australia (CCbyA). 

You are free: 

• to copy, distribute, display, and perform the work 

• to make derivative works 

• to make commercial use of the work 

You must give the original author credit. 

More information about CCbyA License: 

http://creativecommons.org/licenses/by/3.0/au/deed.en_GB 

 

 

 

 

 

About Us 

Badan Nasional Penanggulangan Bencana (BNPB) 

http://creativecommons.org/licenses/by/3.0/au/deed.en_GB
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BNPB is Indonesia’s National Disaster Management Agency. BNPB is a non-departmental 
ministerial-level government agency, tasked with providing guidance and direction to the 
efforts of disaster management that includes disaster prevention, emergency response, 
rehabilitation, and reconstruction in a fair and equal. National Disaster Management Agency 
has the function as a policy maker, formulator, and Refugee (IDP) management to act quickly 
and appropriately and effectively and efficiently; and coordinating the implementation of 
disaster management activities in a planned, integrated, and comprehensive. 

http://bnpb.go.id 

Australia-Indonesia Facility for Disaster Reduction (AIFDR) 

 

The Australia-Indonesia Facility for Disaster Reduction (AIFDR) is a joint initiative between 
the governments of Australia and Indonesia. We work to strengthen Indonesia's ability to 
reduce the impact of disasters. The Australian and Indonesian governments at a special 
ceremony on 15 July 2010 launched the Australia-Indonesia facility. The launch marks an 
important event in the strong relationship now shared by both countries and their united 
commitment to better prepare for and respond to natural disasters in Indonesia. 

http://aifdr.org 

 

 

Humanitarian OpenStreetMap Team (HOT) 

http://bnpb.go.id/
http://aifdr.org/
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Free, collaborative maps are uniquely valuable to humanitarian work, especially in places 
where base map data is often scarce, out of date, or rapidly changing. OpenStreetMap is a 
web project to create a free and open map of the entire world, built entirely by volunteers 
surveying with GPS, digitizing aerial imagery, and collecting and liberating existing public 
sources of geographic data. The Humanitarian OpenStreetMap Team (HOT) is an initiative 
to apply the principles and activities of open source and open data sharing towards 
humanitarian response and economic development. 

http://hot.openstreetmap.org 

Preface 

A Geographic Information System (GIS) is a system designed to enable people to work with 
data related to places on the Earth. A GIS allows the creation, storage, manipulation, and 
analysis of geographic data. GIS is a very broad concept and can involve complex hardware 
and software. But for most people’s purposes, a simple GIS software application is all that is 
required 

GIS in general can be used for a variety of fields, including in disaster management. 
Unfortunately, the GIS software currently on the market are very expensive. Therefore we 
make a guide how to analyze the data with GIS software, which is free and open for the 
purposes of disaster management, particularly in the preparation of contingency plans. 

The software used is QGIS (QGIS) is a Geographic Information System (GIS) that is user-
friendly and open-source. InaSAFE is a free software and open-source, that can create 
realistic scenario of natural disasters impact for planning, preparation, and better 
response. InaSAFE is developed by AIFDR through consultation with BNPB. 

Analyzing Data with QGIS and InaSAFE is designed to complement the previous unit to 
collect spatial data with OpenStreetMap for disaster management. 

We hope it can be useful. 

 

  

http://hot.openstreetmap.org/
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Chapter 1: GIS for Disaster Management 

 

 

 

 

 

Learning Objectives: 

• Distinguishing between data and information 

• Understand the concept of GIS 

 

 

1.1 The difference between data and information 

In the first unit, we looked at OpenStreetMap and how to collect data and add it to the 
worldwide map. But what do we mean when we say that we collect data? Is this the same 
as collecting information? Well, not exactly. 

Data are raw facts. Information is data that is organized and presented in such a way as to 
be useful. In other words, when we go mapping to collect locations and facts about those 
locations, we have collected data - we have collected facts. To turn this data into 
information, we must make sense of it. We must present the data in such a way that it can 
be easily understood. 

OSM data is already made informative in an obvious way. The map that you see when you 
visit the OSM website is there because a computer has processed all of the OSM data and 
used it to paint a nice looking map. The map is informative, and useful for us to see where 
places are in relation to us. 

In this unit we will take this even further. We will learn how to perform geographic data 
analysis, and thereby learn how to make our data more useful, informative and effective. 

1.2 Terminology of Geographic Information System (GIS) 

A Geographic Information System (GIS) is a system designed to enable people to work with 
data related to places on the Earth. A GIS allows the creation, storage, manipulation, and 
analysis of geographic data. GIS is a very broad concept and can involve complex hardware 
and software. But for most people’s purposes, a simple GIS software application is all that is 
required, and in this unit we will learn how to use the excellent open-source application, 
QGIS. 
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GIS provides different ways to analyse data. It enables us to ask complex questions, such as: 

• Where are all schools with more than 100 students? 

• How many children live in a certain district? 

• How many women live within 500 meters of a certain hospital? 

• What is the shortest walking path from a given point to a hospital? 

GIS helps us to answer these sorts of questions. In the previous unit we learned how to 
collect data, and in this unit we will see how to analyse it. 
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Chapter 2: QGIS and InaSAFE in Disaster 
Management 

 

 

 

Learning Objective: 

• Understand the role of GIS in disaster management 

• Understand the importance of data 

• Understand the benefits of QGIS/InaSAFE in disaster management. 

2.1 GIS for Disaster Management 

GIS has an important role in disaster management. A disaster management is intended to 
manage and support both government and community preparedness, mitigation, 
prevention, response and recovery of a potentially hazardous event, such as an earthquake 
or tsunami. The purpose of this disaster management is to minimize casualties and losses 
in case of such an event. 

Before contemplating a disaster management, one must first consider potential disaster 
scenarios. A good disaster management will likely answer questions such as: 

• What sort of disaster is likely to happen? 

• How we prevent the disaster? 

• How widespread will the impact be? 

• Who is responsible for helping? 

• What should be given as aid? 

• What should we do when the disaster already happen? 

• Where are the priority areas? 

In other words, disaster management answers the question, who does what, where and 
when? 

A Geographic Information System is able to help planners answer these questions, 
especially the important spatial elements of contingency planning. GIS may be used to 
model hazardous events so that they can be better predicted. 

It may be used to plan evacuation routes prior to a disaster. When a disaster occurs, GIS 
may also play a role in the emergency response phase. It can be used to map the area 
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affected and position of refugee camps, so that helpers can be directed to the most useful 
locations to aid those affected. After a disaster, GIS may also be used to plan for 
rehabilitation and reconstruction. Overall, GIS helps to perform analysis of a disaster, 
damage and losses caused, and opportunities for reducing risk. 

2.2 The Importance of Data 

We previously learned how to start collecting exposure data. When thinking about GIS it is 
important to remember that if your data is bad, your analysis will be bad also. Hence the 
more detailed and accurate your data is, the better your analysis and action may be during 
a disaster. 

As we shall see in this unit, some data may be obtained from various agencies that 
specialize in certain kinds of data. For example, we will obtain our hazard models (hazard 
data) from various organizations that specialize in this. As for exposure data, some data we 
may find through agencies, such as population data. For infrastructure data, collecting data 
at a community level is key, which is why in the previous unit we learned how to utilize the 
crowd-sourced OpenStreetMap platform. 

2.3 QGIS and InaSAFE 

QGIS is a user-friendly open-source Geographic Information System (GIS). It runs on 
Windows, Mac OSX, and Linux. QGIS provides a continually growing number of capabilities 
provided by core functions and plugins. You can visualize, manage, edit, analyse data and 
compose printable maps. 

QGIS is great because: 

• It’s completely free. It doesn’t cost anything. 

• It’s free, as in liberty. If you think a feature is missing, you can sponsor the 
development of a feature, 

• Or add it yourself if you are familiar with programming. 

• It’s constantly developing and improving. Because many people continue adding 
features, it keeps getting better. 

• Extensive help and documentation is available. If you have problems you can 
always turn to the software documentation, 

• Other QGIS users, or even the developers. 

QGIS has many plugins which extend the core functionality of the software. One of these 
plugins is InaSAFE, which can be used to analyse the impact of a disaster and create a list of 
actions needed to be taken when a disaster occurs. QGIS and InaSAFE can also help to 
determine the location of ideal places of refuge, evacuation routes, areas likely to be 
damaged, and more. 
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InaSAFE provides overviews of potential disaster scenarios, of their outcomes, as well as 
maps which can aid decision makers when disaster strikes. Maps are an effective way of 
communicating disaster impact, by showing in a simple way the areas of damage, such as 
the extent of flood-affected areas and buildings affected by a flood. 
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Chapter 3: The Basics of QGIS 

 

 

 

 

Learning Objectives 

• Downloading QGIS 

• Install QGIS 

• Open a previously created QGIS project 

• Understand the layers panel 

• Access basic tools through toolbar 

• Clean up the toolbar 

• Show a map in the map window 

In this chapter we begin using QGIS. We’ll see how to install the software and understand 
the layout, interface and core functions of the software. By the end of this chapter, you’ll be 
on your way to becoming a competent GIS user! 

Note that if you have previously installed QGIS, feel free to skip ahead to section three. 
Otherwise, let’s start here and get QGIS installed. 

3.1 Getting QGIS 
1. Open your web browser and in the address bar at the top of the window, type qgis.org. 

Press Enter. 

 

The QGIS website will look something like this: 
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2. Click Download Now 

 

3. If you are using Windows, scroll down to the Long Term Release version and click on 
QGIS Standalone Installer Version 2.8 (32 bit). Your exact version number may be 
different. 
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4. If you are not using Windows, select your Operating System from the menu. Follow the 
installation instructions. 

 

5. When the file is downloaded, run it and follow the instructions to install QGIS. 

3.2 Installing QGIS 
1. Open the folder where you have the QGIS installation file. 

 

2. Run the installation file. If you are installing QGIS version 2.x, it should look like this: 
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3. Click on Next. 

4. Click I Agree to agree with the conditions in the license agreement. 

 

5. The next window asks where you would like to install QGIS. In most cases, the default 
should be fine. Click on Next. 
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6. In the next window, click Install without checking any of the boxes. 

 

QGIS will begin to install. It may take a few minutes to complete. 
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7. click Finish to complete the installation. Your computer will automatically reboot. 

 

8. Now open QGIS from the Start Menu. 

 

QGIS will look something like this: 
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3.3 QGIS user interface layout 

Next we will open up a QGIS project, and take a look at the different pieces of the QGIS 
interface. If you installed InaSAFE previously, make sure it is closed by clicking on the X in 
the upper right corner of the InaSAFE panel. If it isn’t open or you haven’t installed it yet, 
carry on. We will come back to this later. 

1. Click on the folder icon on the upper toolbar or go to Project --> Open... 

 

2. Navigate to the tutorial files and go into the qgis/ directory. Open the file named 
sleman_2_2.qgs. QGIS should now look something like the following image. Let’s 
pause for a moment and go over the various components of the QGIS interface. 

 



 

QGIS and InaSAFE for Disaster Management 
13 

Map Canvas 

This is the window where the map is shown. Our project has two different files open, one 
which shows districts of the Sleman regency, and another that shows the railway line 
running through the area. Both of these files are drawn together in the map canvas. 

Layers Panel 

On the left side of QGIS is the layers list. This lists the layers, or files, that are loaded into 
our QGIS project. In this project, we have two layers, Kecamatan_Sleman and 
railway_Sleman_OSM. 

The layers panel not only shows all the files that are currently open, it also determines the 
order that they will be drawn on the map canvas. A layer that is at the bottom of the list will 
be drawn first, and any layers above it will be drawn on top. 

1. Click on the layer railway_Sleman_OSM and drag it below the layer named 
Kecamatan_Sleman. 

 

Notice how the map canvas changes. The railway layer is now shown below the district 
layer, and part of the railway is now obscured. A map should never show railway hidden 
beneath district areas, so go ahead and move the layers back. 

2. Uncheck the box next to a layer’s name. It will be hidden from the map canvas. 

3. Expand collapsed items by clicking the arrow or plus symbol beside them. This will 
provide you with more information on the layer’s current appearance. 

4. Right-click on a layer to view a menu with menu extra options. You’ll be using some of 
them before long, so take a look around! 

Toolbars 

At the top of QGIS are a large number of tools, which are contained within various toolbars. 
For example, the File toolbar allows you to save, load, print, and start a new project. We 
already used one of these tools when we opened this project. 

 

By hovering your mouse over an icon, the name of the tool will appear to help you identify 
each tool. 

The number of tools (buttons) can seem a bit overwhelming at first, but you will gradually 
get to know them. The tools are grouped into related functions on toolbars. If you look 
closed you can see a vertical array of ten dots to the left of each toolbar. By grabbing these 
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with your mouse, you can move the toolbar to a more convenient location, or separate it so 
that it sits on its own. 

 

If you feel overwhelmed by the number of toolbars, you can customize the interface to see 
only the tools you use most often, adding or removing toolbars as necessary. 

1. To add or remove a toolbar, right-click on any of the toolbars, or go to View --> 
Toolbars. 
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2. Let’s remove some of the toolbars that we will not be using in this training, to make 
the interface a bit cleaner. Right-click on the toolbar, and uncheck the boxes next to the 
following toolbars: 

– Advanced Digitizing 

– Database 

– GRASS 

– Label 

– Raster 

– Vector 

3. After removing these toolbars and moving them around, your tools should look like 
this: 

 

Even if they are not visible in a toolbar, all of your tools will remain accessible via the 
menus. For example, if you remove the File toolbar (which contains the Save button), you 
can still save your map by going to Project --> Save. 

Status Bar 

The status bar shows information about the current map. It allows you to adjust the map 
scale and see the mouse cursor’s coordinates on the map. 

 

The coordinates of this map are the same type of coordinates that are recorded by GPS 
devices. The status bar show shows the longitude and latitude of your mouse cursor. 

This may not all be clear right now, but as you progress in your knowledge of GIS is will 
make more and more sense. 

3.4 Adding a Vector Layer 

Now we will add an additional layer containing roads to our project. 

1. Click on the Add Vector Layer button on the toolbar. 

 

2. A dialog box will open. Click the Browse button. 
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3. Navigate to the file qgis/Sleman/Jalan_Sleman_OSM.shp (you may need to unzip the 
file Sleman.zip). Select the file and click Open. 

 

4. You should now see your new layer appear both in the map canvas and in the layers 
panel. It should be drawn above both the district and railway layers. 

 

Note: 

One of the most common file formats are shapefiles, which end with the extension .shp. Shapefiles 
are often used to save geodata, and are commonly used with GIS applications like QGIS. 
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3.5 Basic QGIS Tools 

We’ve already taken a look at the QGIS toolbar and seen the tools for opening a project and 
adding a new layer. Here’s a list of some other commonly used tools. Feel free to play 
around with them if you like. The important thing for now is to start getting familiar with 
QGIS. 

 
Toggle Editing Edit features in a layer 

 
Pan Map Drag the map to a new location 

 
Zoom In Zoom in on the map 

 
Zoom Out Zoom out on the map 

 
Zoom Full Zoom so that all layers fit in the map window 

 
Open Attribute Table Open a layer’s attribute table 

 

Select Single Feature Select a feature in the selected layer 

3.6 Navigating the Map 

Before we examine the attributes of individual features, let’s take a quick look at how to 
navigate the map. The main controls for moving the map around and zooming in and out 
are by default on the panels at the top of QGIS. 

 

When you click on one of these buttons, it changes what you can do with your mouse in the 
main map window. 

1. Select the first button that looks like a hand. Now hold the left mouse button down and 
drag the mouse in the map window. This allows you to pan the map, or move it 
around. 

2. The button which has a plus sign below a magnifying glass allows you to zoom in on 
the map. Select this button. Using your mouse, draw a box around an area where you 
want to zoom in, and release your mouse. 

3. The button which has a minus sign below a magnifying glass allows you to zoom out 
on the map. Select this button and click on the map. 

4. The button that looks like a magnifying glass with red arrows pointing away from it 
lets you zoom to the full extent of your map. Click this button to see all of the data that 
is loaded in the project fit into the map canvas. 
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3.7 Managing Plugins 

QGIS has core functionality, which we will continue to explore in this guide, but it also 
allows the use of additional plugins, which allow you to add functionality to the software. 
Again, these plugins are free. To use them, you simply need to connect to the internet and 
install. To install new plugins, make sure you are connected to the internet. They first need 
to be downloaded, and then activated. Some plugins are already downloaded and available, 
and you can see them by going to Plugins ‣  Manage and Install Plugins. 

 

This displays a list of plugins that have already been downloaded and can be activated. To 
enable a plugin, check the box next to it in this menu. For now, let’s leave all the plugins as 
they are. We’re going to download and activate a new plugin in the next section. 

 



 

QGIS and InaSAFE for Disaster Management 
19 

3.7.1 Installing Plugins 

There are many more plugins, but they must first be downloaded. To download a plugin, 
click the Not installed tab. This will load available plugin repositories, and you will see a list 
of all available plugins for download. 

 

Note that plugins which have already been downloaded can be activated or deactivated 
from the Installed tab. If it has not yet been downloaded, downloading a plugin from the 
Not installed tab will automatically activate it. 

3.7.2 The OpenLayers Plugin 

The OpenLayers plugin allows you to view various web maps as a layer in QGIS. This means 
that you can access the OSM slippy map, Google Maps and Bing Maps from within QGIS. 
Follow along and we’ll see how this works. 

1. Go to Plugins --> Manage and Install Plugins… and click on the Not installed tab. Type 
openlayers into the Search box. 
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2. Select OpenLayers Plugin from the list and click Install plugin. 

 

It may take a few minutes to download. 

 

3. When the download finishes click OK. 
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4. Now the OpenLayers plugin is installed and activated. Click the Installed tab to see it in 
your list of active plugins. Click Close when you are finished. 

 

5. The new plugin provides a menu which offer extra functionality. Go to *Web --> 
OpenLayers plugin* to see various map layers that can be loaded. 
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6. Go to Web --> OpenLayers plugin --> Bing Maps --> Bing Aerial. A new layer called 
“Bing Aerial” will be added to the Layers panel, and the imagery will load in the map 
canvas. If the layer is above your other layers, drag it to the bottom of the layers list. 

 

Your project should now look like this: 
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If you pay attention, there is something wrong with the maps. Can you guess what it is? All 
three layers above Bing Aerial layers should be shown on the map. 

7. To fix this, go to View --> Panels and check the box next to Layer order. 
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8. The Layer order panel will appear next to Layers panel (1). Click that panel and 
uncheck Control Rendering Order (2). 
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9. Return to the Layers panel. The map should appear in correct order. All layers above 
Bing Aerial will show up on the map canvas as in the image below. 
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Adding a layer such as Bing Aerial will change the Coordinate Reference System, or CRS, of 
your project. Essentially this means that your project is not using longitude and latitude 
coordinates anymore. This shouldn’t affect you right now, but it will make sense later when 
we cover CRSes. 

10. If the map data does not appear to match up correctly with the aerial imagery, it may 
be due to different CRSes. You can fix this problem by going to *Project --> Project 
Properties* and checking the box next to Enable ‘on the fly’ CRS transformation. 
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11. Great! Now we can see our map data on top of an aerial photograph of the earth. Note 
that this is the same imagery provided by Microsoft Bing that you would load for 
editing in JOSM. Try unchecking the box next to the layer Kecamatan Sleman so that 
you can see the area better. Zoom in close to see detailed imagery with our street and 
railway layers displayed on top. 
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12. Remove the Bing Aerial layer by right-clicking it in the Layers panel and clicking 
Remove. 

13. Try out other layers that are available to you from the Web --> OpenLayers plugin 
menu.. 

3.7.3 Install InaSAFE Plugin 

Now, we are going to install InaSAFE plugin. 

1. Go to Plugins Manage and install plugins menu 

 

2. Go to the Search box and type “inasafe” 
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3. Select InaSAFE and click Install plugin and wait for a moment until a pop-up 
notification showing that plugin has installed successfully. 

 

4. Close the plugin manager window and we will learn about InaSAFE later in Chapter 8. 

Now you already know basic QGIS from installation, understand QGIS layout, learning 
useful toolbar and basic operation in QGIS. You also already learn about how to install 
InaSAFE, a plugin that we will learn more in the last chapter of this module. 
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Chapter 4: Map Projection Basics 

 

 

 

 

Learning Objectives 

• Understand Coordinate Reference Systems (CRS) 

• Identify the CRS of a vector dataset 

• Doing “on the fly” reprojection 

• Save dataset with a different CRS 

• Georeference Digital Image 

We’ve talked a little bit about Coordinate Reference Systems (CRSs) previously, but haven’t 
covered it in depth. In this chapter, we’ll look more at what a CRS means practically, and 
how it affects our work in QGIS. 

4.1 Coordinate Reference System (CRS) 

The CRS that all the data as well as the map itself are in right now is called WGS84. This is a 
very common Geographic Coordinate System (GCS) for representing data. But there’s a 
problem, as we will see. 

1. Open the project world.qgs, located in the qgis/ folder 

2. Zoom in to Indonesia by using the Zoom In tool. 

 

3. Setting the scale in the Scale field, which is in the Status Bar along the bottom of the 
screen. While over Indonesia, set this value to 1:20000000 (one to twenty million). 

 

4. Now pan around the map while keeping an eye on the Scale field. 

Notice the scale changing? That’s because you’re moving away from the one point that you 
zoomed into at 1:20000000, which was at the center of your screen. All around that point, 
the scale is different. 
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To understand why, think about a globe of the Earth. It has lines running along it from 
North to South. These longitude lines are far apart at the equator, but they meet at the 
poles. In a GCS, you’re working on this sphere, but your screen is flat. When you try to 
represent the sphere of the earth on a flat surface, it becomes distorted, as if you took an 
orange peel and tried to flatten it. What this means on a map is that the longitude lines stay 
equally far apart from each other, even at the poles (where they are supposed to meet). 
This means that, as you travel away from the equator on your map, the scale of the objects 
that you see gets larger and larger. What this means for us, practically, is that there is no 
constant scale on our map! 

To solve this, we’ll use a Projected Coordinate System (PCS) instead. A PCS “projects” or 
converts the data in a way that makes allowance for the scale change and corrects it. 
Therefore, to keep the scale constant, we should reproject our data to use a PCS. 

 

 

4.2 “On the Fly” Reprojection 

Every QGIS project has a CRS, and each of the data layers have a CRS too. Often these are 
the same. Your project may be in WGS84, and the layers too. But sometimes you will add a 
layer that is not in the same CRS as the project, and you need QGIS to convert it so that it 
can be displayed along with the rest of the data. The term that we use for this is 
reprojecting on the fly. 

1. To enable “on the fly” projection, click on the CRS Status button in the Status Bar along 
the bottom of the QGIS window: 

 

2. In the dialog that appears, check the box next to Enable ‘on the fly’ CRS transformation. 

 

3. Type the NSIDC into the Filter field. One CRS NSIDC EASE-Grid Global will appear in 
the list below. 

note 

Projection is the act of taking coordinates on a sphere (like the earth), and manipulating them so that 
they can be displayed on a flat surface. 
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4. Click on it to select it, then click OK. 

5. Notice how the shape of Indonesia changes. All projections work by changing the 
apparent shapes of objects on Earth. 

6. Zoom in to a scale of 1:20000000 again, as before. 

7. Pan around the map. 

8. Notice how the scale stays the same! 

 

 
 

9. Deactivate “on the fly” reprojection again, by unchecking the box next to Enable ‘on the 
fly’ CRS transformation. 

10. Now let’s add another vector layer, located in qgis/peta\_dunia/Indonesia.shp. What 
do you notice? The layer isn’t visible! But that’s easy to fix,right? 

11. Right-click on the layer in the Layers list. 

12. Select Zoom to Layer Extent. 

 

 

note 

'On the fly' reprojection is useful for combining datasets that are in different CRSes 
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OK, so now we see Indonesia... but where is the rest of the world? 

It turns out that we can zoom between these two layers, but we can’t ever see them at the 
same time. That’s because their Coordinate Reference Systems are so different. The 
continents layer is in degrees, but the Indonesia layer is in meters. In other words, one 
feature in the continents layer might be 8.5 degrees away from the equator, but the same 
feature in the Indonesia layer might be 900000 meters away from the equator. 

8.5 degrees and 900000 meters is about the same distance, but QGIS doesn’t know that! 
One of our layers must be reprojected to match the other layer. 

To correct this: 

1. Switch Enable ‘on the fly’ CRS transformation on again as before. 

2. Zoom to the extents of the Indonesia dataset. 

Now, because they’re made to project in the same CRS, the two dataset fit perfectly: 

 

When combining data from different sources, it’s important to remember that they might 
not be in the same CRS. 'On the fly' reprojection helps you to display them together. 

4.3 Dataset with different CRS 

It’s great that QGIS can reproject layers on the fly so that we can work with them in the 
same project. But this requires more time for our computer to reproject the layers, and can 
slow down our work. For this, or for other reasons, we might want to be able to reproject a 
dataset, and save it with the new projection. 

Let’s reproject the Indonesia layer so that it is in the same CRS as the project. To do this, we 
will need to export the data to a new file using a new projection. 
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1. Right-click on the Indonesia layer in the Layers list. 

2. Select Save As... in the menu that appears. You will be shown the Save vector layer as... 
dialog. 

3. Click on the Browse button next to the Save as field. 

4. Navigate to qgis/peta_dunia/ and specify the name of the new layer as 
Indonesia_terproyeksi.shp. 

5. Leave the Encoding unchanged. 

6. Change the value of the Layer CRS dropdown by click on Select CRS icon in the right 
panel. 

 

7. A Coordinate Reference System Selector window will appear. Type 4326 in Filter 
Box 

8. and select WGS 84 in the bottom side of the window. 

 

8. Click OK. You will back to Save As… window. 
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9. Check the box next to Add saved file to map. 

10. The Save vector layer as... window now looks like this: 

 

11. Click OK and after a minute, you should be presented with a notification above map 
canvas telling that the process is finished. 

12. Now your new layer, Indonesia\_terproyeksi, will be shown in the layers panel. If you 
turn off on the fly reprojection, this layer will still be shown correctly, because it has 
been reprojected into the same CRS as the project (and the continents layer). 

4.4 Georeferencing Scanned Image 

Georeference is the process of associating a physical map or raster image of a map with 
spatial locations and may be applied to any kind of object or structure that can be related to 
a geographic location, such as point of interest, roads, places, bridges, or buildings. 
Georeferencing is crucial to making aerial or satellite imagery and also raster images to be 
able to overlay with other spatial data, like vector data and raster data. 
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To georeference an image, we need to establish point with geographic coordinates in these 
point, known as control points. This control point refer to actual position of objects in 
earth. These coordinates are obtained by doing field survey. For example, we need to 
georeference an aerial image and we know location an object in aerial image with exact 
location in earth. To georeference this, simply input the control points with coordinates 
that we know from field survey. We need 4 control points or more to georeference the 
image. 

Let’s start to georeference an image that we got from Geospasial BNPB. 

1. Go to Raster --> Georeferencer --> Georeferencer…. 

2. A new window will appear. Click Open Raster icon in upper left side of the window. 

 

3. Select peta\_krb\_merapi\_2002.jpg and click Open. 

4. In Coordinate Reference System Selector type 4326 in filter box and select WGS 84 as 
CRS. 

5. An image will be appear in Georeferencer Window. 

6. You can use the zoom/pan controls in the toolbar to learn more about the map. 

 

7. If you look closely, you will see coordinate grid with markings. Using this grid, you can 
determine the X and Y coordinates of the points where the grid intersect. Click on Add 
Point in the toolbar. 

http://geospasial.bnpb.go.id/
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8. A new pop-up window will appear, enter the coordinates. 
9. For Indonesia enter X for Bujur (BT) and Y for Lintang (LS). Click OK. It can use 

decimal degree (dd,dd), projected coordinates/UTM (mmmm,mmm) and degree 
minutes seconds (dd mm ss,ss) format. Don’t forget to put Negative ( - ) in Y/North 
value for area in South part of equator. 

 

9. Notice that GCP table in bottom window has a row with detail of your first GCP. 

10. Now, let’s add at least 4 GCPs that cover entire image. More GCP’s points will result 
more accurate image. 
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11. After input 4 or more points, click Transformation Setting in toolbar. 

 

12. The Transformation Setting Window is displayed. Follow all setting like this: 

note 

Right click the entry in GCP Table to delete the GCP Point or select Delete Control Point tool in toolbar above the image, 
then use it to click on the Control Point in either the GCP table or Workspace Window. 
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note 

In QGIS there are several method s for transforming the image, these are linear, Helmert, the 1st, 2nd and 3rd 
order polynomials, and the thin plate spline. These different Transformation Methods interpret your Control 
Point in different ways, and control how the map is fitted and warped to your georeferenced base map. 

For best fit, the thin-plate spline or higher-number polynomial transformations are often best. Its look like a 
true rubber sheeting method, transforms the source Control Point exactly to the target Control Points, and 
optimize for local accuracy opposed to global accuracy. 

 



 

QGIS and InaSAFE for Disaster Management 
40 

13. To finish and export your georeferenced map, click the Start Georeferencing 
button 

14. In the Main Toolbar at the top of the QGIS Workspace. 

 

14. The Georeferencing is now complete. The georeferenced layer will loaded in QGIS Map 
Canvas. 

 

Knowing how to georeference is important when we want to digitize from a paper map or 
an image that is not already georeferenced. Once the image already georeferenced like this, 
it can apply the same digitization techniques that we will learn in the next chapter to create 
vector shapefiles that can be used in QGIS and InaSAFE. 
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Chapter 5: Working with Vector Data 

 

 

 

 

Learning Objectives 

• Understand vector data 

• Identify attribute of vector data 

• Create vector data 

• Add vector layers 

• Symbolize vector layers 

• Add labels to vector layers 

In this chapter, we will learn what is meant by vector data. We will practice adding it to our 
QGIS projects, and we will learn how to style the data in different ways. 

5.1 Vector Data 

Vector data is the most common type of data found in GIS. A vector is essentially something 
in the form of a dots, or lines connecting those dots. In other words, points, lines, and 
polygons are all vectors. (Curved lines are vectors too, but we won’t worry about that for 
now) We are already quite familiar with vector data because in the previous unit, we used 
JOSM to create it! 
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Each object in a vector dataset is referred to as a feature. When we are using JOSM we often 
refer to them as objects, but in traditional GIS terminology they are features. A polygon that 
represents a building is a feature, as is a line that represents a river. Each feature has a 
geographic location, and is attached to other data that describe the feature. 

One important thing to note is that QGIS layers can only contain one type of feature. That is, 
one layer can’t contain both point features and line features, because they are different 
types of data. Hence if you have a file that contains school polygons and another file that 
contains school points, you would add them as two separate layers. 

Almost always, polygon layers will be at the bottom of your layer list, line layers in the 
middle, and point layers at the top. You don’t generally want your polygons overlapping 
your lines and points. 

5.2 Attribute Data 

It’s important to know that the data you will be working with does not only represent 
where objects are in space, but also tells you what those objects are. 

1. Open the project sleman_2_5.qgs. This is the same project that you worked with 
previously. 

2. Close the InaSAFE panel if you still have it open. 

3. You can see in your project the position of Sleman districts, the railway, and some 
roads, but you can’t see all of the data contained in those layers. 

4. Select Jalan_Sleman_OSM in the layers list. 

 

5. Click the Open Attribute Table button: 

 

6. You will see a table with more data about the streets layer. This extra data is called 
attribute data. The lines that you can see on your map represent where the streets go 
- this is the spatial data. You will remember in JOSM that there was the same division. 
The points, lines, and shapes you drew tell us where , but the tags, or attributes, tell us 
what. These definitions are commonly used in GIS, so it’s essential to remember them! 



 

QGIS and InaSAFE for Disaster Management 
43 

 

7. Take a look at the attribute table. Each row in the table is associated with one feature 
in the streets layer. Each column contains one of the attributes. If you select other 
layers and click on the Open Attribute Table button, you’ll see different tables. 

8. Close the attribute table. 

5.3 Creating Vector Data 

Before you can add new vector data, you need a vector dataset (a layer to add it to). In our 
case, we’ll begin by creating a new data layer, and then we will discuss how to edit existing 
vector layer in QGIS, and how to create an entirely new dataset. 

1. Create a new project in QGIS by clicking on the New Project icon. 

2. Go to Layer ‣  Create Layer ‣  New Shapefile Layer. You’ll be presented with the 
following dialog: 



 

QGIS and InaSAFE for Disaster Management 
44 

 

At this point we must decide what kind of dataset we want to create. Remember that a data 
layer can only contain feature of points, lines, or polygons – never a mix. When we create 
the layer, we must define what type of data it will contain. 

Since polygon are made up of points and lines. Let’s jump into polygons. Once you’ve 
mastered this, creating a point or a line should be easy! 

3. Check the box next to Polygon. 
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4. We’ll specify the Coordinate Reference System (CRS) in the next box. By default the 
box will contain the CRS of the project, which for us will be WGS84. This is a widely 
used and very useful CRS, so let’s stick with it! 

 

5. When we create our new layer, the attribute table will only have one column by 
default - id. This attribute contains a unique id number for every feature. We can add 
additional fields to the attribute table now, when we create the layer. Let’s add a name 
field. 

6. Type keterangan into the boxt next to Name. The setting should match those shown 
here: 

 

7. Click the Add to attributes list button. Your attributes list should now look like this. 

 

8. Click OK. A save dialog will appear. 

9. Navigate to a directory of your choosing. 

10. Save the new layer as krb_merapi.shp. 

 
11. The new layer should appear in your Layer panel. 

note 

Shapefile is a commonly used geographic file format. It can easily be 
converted into other formats, and most GIS software can read this type of 
file. 
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5.3.1 Digitising Vector Data 

Digitising, as you might have guessed, is the art (or science) of creating digital vector data 
from another source, such as a raster image. In order to begin digitising, we must firt enter 
edit mode. GIS software commonly requires a separate mode for editing, to prevent user 
from accidentally editing or deleting important data. Edit mode is switched on or off 
individually for each layer. 

1. Open raster layer peta_krb_merapi_2002_modified.tif in left QGIS toolbar: 

 

2. Open vector layer krb_merapi.shp: 

 

3. Select krb_merapi.shp in the Layers panel. 

4. Click on the Toggle Editing button: 

 

5. If you can’t find this button, ensure that the Digitising toolbar is enabled. There should 
be a check mark next to the View ‣  Toolbars ‣  Digitizing menu entry. 

6. One you are in edit mode, the digitising tools will become active: 

 

From left to right on the image above, they are: 

• Toggle Editing: activates / deactivates edit mode. 

• Save Layer Edits: saves changes made to the layer. 

• Add Feature: start digitising a new feature. 

• Move Feature(s): move an entire feature around. 

• Node Tool: move only one part of a feature. 

• Delete Selected: delete the selected feature (only active if a feature is selected). 

• Cut Features: cut the selected feature (only active if a feature is selected). 

• Copy Features: copy the selected feature (only active if a feature is selected). 

• Paste Features: paste a cut or copied feature back into the map (only active if a feature has been cut or 
copied). 

7. Before you start digitising, go to Setting ‣  Snapping Options… 

8. Change Snapping mode to Advanced, and check krb_merapi layer with Mode to 
vertex and segment and Tolerance value is 1 and then set Units to pixels: 
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9. Click OK. 

10. Let’s add new feature. Click on the Add Feature button to start digitising: 

 

11. Start by clicking on a point somewhere along the edge of the dark pink area. 

12. Place more points by clicking further along the edge, until the shape you’re drawing 
completely covers the field. This is very similar to drawing a polygon in JOSM. 

note 

It’s important to check Avoid intersection if you want to create a polygon with each feature snap each 
other. 
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13. To place the last point, right-click where you want it to be. This will finalise the feature 
and bring up the Attribute form filling dialog. 

14. Fill in the values as shown here: 

 

15. Click OK. 

If you make a mistake while digitising a feature, you can always edit it later. Simply finish 
digitising the feature and then follow these steps: 

• Select the feature with the Select Feature tool: 
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• Then use one of these tools to edit the feature: 

 

Move feature(s) tools Move entire feature(s) 

 

Node tools Move only one point where you may have misclicked 

 
Delete selected Get rid of the feature entirely so you can try again 

 
Undo Undo mistakes or press Ctrl + Z on keyboard 

Now try it on your own: 

16. Digitise all the hazard prone area from inner circle and then to outer circle. Use the 
image to assist you and if you confused about what information for each colours, you 
might need to look at the legend on the right side. 

 

17. Remember that each new feature need to have a unique id value! 

When you are finished adding feature to a layer, you must savee the changes to that layer. 

18. Click on the Toggle Editing button. 

19. You will be asked to save your edits. Click Save. 
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Now you know how to create polygon feature! Creating points and line layer is just as easy 
– you simply need to define the type of layer when you create it, and of course you can only 
create point in point layers and lines in line layers. 

5.4 Adding Vector Data 

As we mentioned previously, a shapefile is a commonly used geographic file format. It can 
easily be converted into other formats, and most GIS software can read this type of file. You 
may notice when adding a shapefile that there are numerous files in your shapefile 
directory with the same name. This is because a shapefile actually relies on a collection of 
several other files to store the data and keep various settings. When you add a shapefile to 
your project, you should always add the one that ends in .shp, but the rest of the files are 
important too! 

• Do you remember how to add a shapefile? Try adding the layer POI_Sleman_OSM, from 
the shapefile located in the tutorial directory. If you don’t remember how to add a new 
vector layer, refer to the instructions in chapter 2. 

• Your project should look like this after the new layer has been added: 
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Databases 

Shapefiles (and other types of files) are one way to store geographic data. You can also load 
a vector layer into QGIS from a database. You may already be familiar with Database 
Management Systems (DBMS) such as Microsoft Access. GIS applications also make use of 
databases to store geographic data. Databases can be hosted and used locally on your 
computer, or could be shared between users over a network or even the internet. 

• Let’s try adding a layer from a database. Click on the following icon. If you can’t find it, 
right-click on the toolbar and make sure that the “Manage Layers” toolbar is enabled. 

 

• You will see a dialog box. Click New. 

 

• Navigate to the qgis_data/Sleman folder and find the file guna_lahan.db. Select the file 
and click Open. 

• Now in the original dialog box, you will see that the dropdown button now contains 
guna_lahan.db @..., followed by the path of the database file on your computer. 
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• Click Connect. You will see the following in the box: 

 

• This database actually has three different layers available, all saved in the database. 
Click on the first layer to select it, then hold SHIFT and click the last layer to select 
them all. 

• Click Add. This will add all three layers to our project. 

 

• The layers you have just added are all polygon layers, so you will want to drag them 
down below the line and point layers. If you have a checkbox beneath your layers list 
that reads Control rendering order, go ahead and check it. 

• Let’s remove a couple of layers to make it easier to deal with our data. Right-click on 
the railway and district layers and click Remove. Then order your layers like this: 

 

note 

Remember frequently to save your map! Your QGIS project file does not save the data (data is saved in a 
shapefile or a database), but it does remember the layers that you have added to the project, their order, 
and any settings that you adjust. 
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5.5 Symbology 

The symbology of a layer is its visual appearance on the map. One of the basic strengths of 
GIS is that you have a dynamic visual representation of the data you’re working with. 
Therefore, the visual appearance of the map (which depends on the symbology of the 
individual layers) is very important. The end user of the maps you produce will need to be 
able to easily see what the map represents. Equally as important, you need to be able to 
explore the data as you’re working with it, and good symbology helps a lot. 

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s 
essential for you to use a GIS properly and produce maps and information that people will 
understand and be able to use. 

5.5.1 Changing colors 

To change a layer’s symbology, we will open its Layer Properties. Let’s begin by changing 
the color of the pemukiman layer. 

1. Right-click on the pemukiman layer in the Layers list. 

2. Select the menu item Properties in the menu that appears. 

 
3. In the Properties window select the Style tab. 

 

note 

By default you can also access the Properties menu by double-clicking on the name of the layer. 
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4. Click the color button to change the color 

 

5. A standard color dialog will appear. Choose a grey color and click OK. 

 

6. Click OK again in the Layer Properties window, and you will see the color change being 
applied to the layer. 
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5.5.2 Changing Symbol Structure 

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we 
want to change the color of the vegetation, but we also want to eliminate the lines between 
the different types of vegetation so as to make the map less visually cluttered. 

1. Open the Layer Properties window for the vegetasi layer. Under the Style tab, you will 
see the same kind of dialog as before. This time, however, we will do more than just 
change the color. 

2. Click on the Simple Fill under the symbol layer column panel. Then Symbol layer 
dialog will appear next to the symbol layer column panel. 

 

3. Change the color inside the polygons in the layer by clicking the button next to the Fill 
label: 
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4. In the dialog that appears, choose a new color (that seems to suit vegetation). 

5. Click OK. 

6. Next, we want to get rid of the lines between all the farms. 

7. Click on the Border style dropdown. At the moment, it should be showing a short line 
and the words Solid Line. 

 

8. Change this to No Pen. 

9. Click OK, and then OK again. Now when we look at our map, the vegetasi layer will 
have a new color and no lines between polygons. 
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10. Try changing the symbology of the pemukiman layer so that it also does not have 
outlines. 

5.5.3 Scale-based Visibility 

Sometimes you will find that one of your layers is not suitable for a given scale. For 
example, if you have a layer which shows the earth’s continents but not with very much 
detail, the continent lines may not be very accurate when you are zoomed in very far to see 
streets. 

 

In our case, we may decide to hide our streets layer when we are zoomed out very far (a 
small scale). For example, the streets layer is not very useful when we are zoomed out far 
and it looks like a blob. 

Let’s enable scale-based rendering: 

1. Open the Layer Properties dialog for the Jalan_Sleman_OSM layer. 

2. Activate the General tab. 

 

3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent 
visibility. Then change the value in “Maximum” to 1:10 and “Minimum” to 1:100000 

 

4. Click OK. 

note 

Scale is a reference to how your map references what is actually on the ground in terms of size. 

Scale is usually given in terms like 1:10000, which means that one centimeter of length on your map is equal 
to 10000 centimeters in the real world. When you zoom in or out on a map, the scale changes, as you can 
see in the status bar at the bottom of QGIS 
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5. Now look at your map and see what happens when you zoom in and out. The streets 
layer should appear when you are at a large scale and disappear at small scales. 

\ 

 

5.5.4 Adding Symbol Layers 

Now that you know how to change simple symbology for layers, the next step is to create 
more complex symbology. QGIS allows you to do this using symbol layers. 

1. Go back to the vegetasi layer’s Symbol properties dialog as before. 

2. In this example, the current symbol has no outline (i.e., it uses the No Pen border 
style). 

 

3. Click on Fill then click + button on the left. 

 

note 

You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to draw a box and 
zoom to it 
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4. Click on it and another symbol layer will be added to the list: 

 

5. Note that it may appear different in color, but we’re going to change that anyway. 

Now this layer has two different symbologies. In other words, both the green color AND the 
blue color will be drawn. However, the blue color will be drawn above the green, and since 
it is a solid color, it will completely hide the green color. Let’s change it. 

It’s important not to get confused between a map layer and a symbol layer. A map layer is a 
vector (or raster) that has been loaded into the map. A symbol layer is part of the symbol 
used to represent a map layer. This course will usually refer to a map layer as just a layer, 
but a symbol layer will always be called a symbol layer, to prevent confusion. 

6. Set the border style to No Pen, as before. 

7. Change the fill style to something other than Solid or No brush. For example: 

 

8. Click OK and then OK and take a look at your layers new symbology. 
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9. Now try it yourself. Add an additional symbology layer to the Jalan_Sleman_OSM 
layer. 

– Give the thickness of the original layer a value of 2.0 

– Give the thickness of the new symbology layer a value of 1.0 

10. This will result in your roads looking something like this: 

 

11. Our streets now appear to have an outline, but they seem disjointed, as if they don’t 
connect with each other. To prevent this from happening, you can enable symbol 
levels, which will control the order in which the different symbol layers are rendered. 

12. In the Layer Properties dialog, click on Advanced ‣  Symbol levels: 
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13. The Symbol Levels dialog will appear. Check the box next to Enable symbol levels. 

 

14. Your map will now look like this: 

 

15. When you’re done, you can save the symbol itself in QGIS so that you won’t have to do 
all this work again if you want to use the symbol again in the future. Save your current 
symbol style by clicking the Save Style ... button under the Style tab of the Layer 
Properties dialog. 
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16. Give your style file a name and save. You can load a previously saved style at any time 
by clicking the Load Style ... button. Before you change a style, keep in mind that any 
unsaved style you are replacing will be lost. 

Symbol levels also work for classified layers (i.e., layers having multiple symbols). We will 
cover classification in the next section, but you can see how it works here with roads. 

5.5.5 Symbol layer types 

In addition to setting fill colors and using predefined patterns, you can use different symbol 
layer types entirely. The only type we’ve been using up to now was the Simple Fill type. The 
more advanced symbol layer types allow you to customize your symbols even further. 

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we 
will look at the types available for points. 

a. Vector Points 

1. Change the symbol properties for the POI_Sleman_OSM layer: 

 

2. You can access the various symbol layer types by clicking a symbol layer (1) then 
clicking the dropdown box in the upper right corner (2) 
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3. Investigate the various options available to you, and choose a symbol layer type other 
than the default Simple Marker. 

4. If in doubt, use an Ellipse Marker. 

5. Choose a light outline and dark fill, with a symbol width of 2.00 and symbol height of 
4.00. 

 

 

b. Vector Lines 

1. To see the various symbology options for vector lines, open the streets layer 
properties and click on the dropdown box: 

 

2. Click on Marker line. 
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3. Click Simple Marker on symbol layers (1) 
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4. Change the symbol properties to match this dialog: 

 

5. Now, click on Marker line on symbol layers panel, then change the interval to 2.00: 

 

6. Your road should now look something like this: 
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Once you have applied the style, take a look at its results on the map. If the dots not shown 
up, check the advanced setting and go back to Symbol level. Change the upper symbol layer 
to “2”. Then click OK. As you can see, these symbols change direction along with the road 
but don’t always bend along with it. This is useful for some purposes, but not for others. If 
you prefer, you can change the symbol layer in question back to the way it was before. 

7. Try to change the appearance of the streets layer again, so that the roads are dark gray 
or black, with a thin yellow outline, and a dashed white line running in the middle. 

 

c. Vector Polygons 

1. Now let’s change the symbol layer type for the pemukiman layer. Take a look at the 
dropdown menu as you’ve done for the point and line layers, and see what the various 
options can do. 

 

2. Feel free to play around with the various options. We will use the Point pattern fill 
with the following settings: 
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3. Add a new symbol layer with a normal Simple fill. 

4. Make it gray with no outlines. 

5. Move it underneath the point pattern symbol layer with the Move down button: 

 

6. The symbol properties should look like this: 



 

QGIS and InaSAFE for Disaster Management 
68 

 

As a result, you have a textured symbol for the urban layer, with the added benefit that you 
can change the size, shape and distance of the individual dots that make up the texture. 

5.5.6 Classified Symbology 

By classifying vector data according to their type, we can give them different symbologies 
and they will still appear to flow into each other. 

 

a. Classifying nominal data 

1. Open Layer Properties for the vegetasi layer. 

2. Go to the Style tab. 

3. Click on the dropdown that says Single Symbol: 

 

4. Change it to Categorized and the interface will change: 
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5. Change the Column to guna_lahan and the Color ramp to Spectral: 

 

6. Click the button labeled Classify: 

 

7. Click OK. You’ll see something like this: 
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8. Click the arrow (or plus sign) next to rural in the Layer list, you’ll see the categories 
explained: 

 

So, this is useful! But it hurts your eyes to look at it, so let’s see what we can do about that. 

9. Open Layer Properties and go to the Style tab again. 

10. Click the Change button next to Symbol. 

 

11. Remove the outline as you did in the previous chapter. (change the border style to “No 
Pen”) 

12. Click the Delete all button: 
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13. Now click Classify again, and the new symbols will appear. 

You’ll notice they don’t have outlines. This is because you just removed the outlines! 

14. Change the color for each type of vegetation by double-clicking on the colored block 
next to its name. You can change the color for each type of vegetation to something 
that you think is more applicable, as we’ve done here: 

 

15. Notice that the category on the bottom is empty. Select it, and click the Delete button. 

16. When we click OK our map looks like this: 

 

If you feel confident in your new classification skills, try to classify the residential layer 
yourself. Use darker colors to distinguish it from vegetation. 

b. Ratio classification 

In the previous example, we classified the vegetasi layer by what is known as nominal 
classification. This type of classification is when categories are defined based on names. 
Next we will classify the pemukiman layer based on the size of each feature. Classifiying 
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with attributes that contain only positive numbers, such as land area, is known as ratio 
classification. 

1. Open the attribute table for the pemukiman layer. Notice the final column, luas_ha. 
This attribute contains the size of the land area contained within that feature polygon. 

 

2. Open the layer properties for pemukiman. 

3. Change the Style type to Graduated, and use luas_ha as the column. 

 

4. Because we are categorizing with numbers this time, a color gradient will be useful for 
representing our categories. Click on “Oranges” in the color ramp, and then click 
Classify. 

 

5. Now you’ll have something like this: 
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Now you already know how to symbolize vector data into various types. You can try to 
symbolize another data such as line or point to make your vector data more informative. 

5.6 The Label Tool 

Labels can be added to a map to show any information about an object. Any vector layer 
can have labels associated with it. Labels rely on the attribute data of a layer for their 
content. 

There are several ways to add labels in QGIS, but some are better than others. You may 
notice that when you open the Layer Properties window for a layer, there is a tab called 
“Labels.” While this tab is designed to put labels on your map, it is not nearly as good as the 
so-called “Label Tool”, which we will learn in this section. 

5.6.1 Labeling Points 

Before being able to access the Label tool, you will need to ensure that it has been activated. 

1. Go to the menu item View ‣  Toolbars. 

2. Ensure that the Label item has a checkmark next to it. If it doesn’t, click on the Label 
item, and it will be activated. The Label toolbar looks like this: 

 

3. Click on the POI_Sleman_OSM layer in the Layers list, so that it is highlighted. 

4. Click on the Labelling button: 

 

This gives you the Layer labeling settings dialog. 
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5. Check the box next to Label this layer with.... 

 

6. We must indicate which of the attribute fields we want to use for the labels. The NAME 
field is the mostly likely candidate for a label, so let’s select NAME from the list: 

 

7. Click OK. The map should now have labels like this: 

 

What we have so far is good, but as you can see, the labels are overlapping the points that 
they are associated with. That doesn’t look very nice. The text is also a bit larger than it 
needs to be. Let’s fix these problems! 

8. Open the Label tool again by clicking on its button as before. 

9. Click on the Text tab button to change the text properties: 
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10. A standard text change dialog appears, similar to those in many other programs. 
Change the font to Arial size 9. 

11. Now click on Buffer tab to add buffer on the text. Check box labelled Draw text buffer 

 

Your labels will now look like this: 
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Now you can see why we usually need label buffers! 

That’s the font problem solved! Now let’s look at the problem of the labels overlapping the 
points. 

12. In the Label tool dialog, click on Distance tab. 

13. Change the value of Label distance to 2. 

 

14. Click OK. The labels no longer hover over the icons, but are “buffered” a short distance 
away: 
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5.6.2 Labeling lines 

Now that you know how labeling works, there’s an additional problem. Points and 
polygons are easy to label, but what about lines? If you label them the same way as the 
points, your results would look like this: 

 

This is not very useful! To make lines behave, we’ll need to edit some options. 

1. Hide the POI_Sleman_OSM layer so that it doesn’t distract you. 

2. Activate labels for the Jalan_Sleman_OSM layer as before. (Remember to use the Label 
tool on the toolbar, not the one in Label Properties!) 

3. Set the font Size to 9 and activate the buffer so that you can see more labels. 

4. Zoom in so that the scale is around 1:10000. 

5. In the Label tool dialog’s Placement tab, choose the following settings: 
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The map will look somewhat like this, depending on scale: 

 

It’s better than before, but still not ideal. For starters, some of the names appear more than 
once, and that’s not always necessary. To prevent that from happening: 

6. Go to Rendering tab 

7. Enable the option Merge connected lines to avoid duplicate labels (also under the 
Rendering tab - you may need to scroll down to see it). 

Another useful function is to prevent labels being drawn for features too short to be of 
notice. 

• Set the value of Suppress labeling of features smaller than ... to 5 mm and note the 
results when you click Apply. 

• Try out different Placement settings as well (also under the Placement tab). As we’ve 
seen before, the horizontal option is not a good idea in this case, so let’s try the curved 
option instead! 

• Select the curved option under the Placement tab of the Layer labeling settings dialog. 

Here’s the result: 

 



 

QGIS and InaSAFE for Disaster Management 
79 

As you can see, this hides a lot of the labels that were previously visible, because of the 
difficulty of making some of them follow twisting street lines and still be legible. You can 
decide which of these options to use, depending on what you think seems more useful or 
what looks better. 

Now that you know how attributes can make a visual difference for your map, how about 
using them to change the symbology of objects themselves? That’s the topic for the next 
section! 
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Chapter 6: Working with Raster Data 

 

 

 

 

Learning Objectives 

• Load Raster Data 

• Change Raster Symbology 

• Terrain Analysis 

Thus far we’ve worked mostly with vector data, which consists of features, and these 
features are themselves made up of points and lines. In this chapter we will learn about 
raster data. Remember when you were editing OpenStreetMap in JOSM? The points, lines 
and shapes that you drew were vector data. But when you loaded Bing aerial imagery in the 
background, that was raster data. So what’s the difference? 

Raster data essentially comes in the form of an image. It is made up of pixels, like a 
photograph, and a raster image will always be some number of pixels wide and some 
number of pixels high. If you zoom in far enough on a raster image, it will start to become 
blurry, just as if you opened a photo on your computer and zoomed in very close. As we’ll 
see in this chapter, however, a raster image can mean more than just a photograph from 
the sky. Follow along and we’ll learn all about rasters! 

6.1 Loading Raster Data 

Not all raster data consist of aerial photographs. There are many other forms of raster data, 
and in many of those cases, it’s essential to symbolise the data so that it becomes properly 
visible and useful. In this section we’ll add a new kind of raster and see how to change its 
symbology. 

1. Click on the Load Raster Layer button: 

 

2. The Load Raster Layer dialog will open. Find the file named popmap10_all.tif. Open it. 

3. When it appears in the Layers Panel, right-click on it and click Rename. Give it the 
name Indonesian Population. 
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When it loads, you’ll notice that the new raster image appears as whole Indonesia’s Islands 
in grey colour. 

 

The layer appears grey (and doesn’t give us any information) because its symbology hasn’t 
been customised yet. In the colour aerial photograph we loaded via OpenLayer Plugin, 
everything is already defined. But if you load a raster image and it’s just a grey rectangle, 
then you know there’s no symbology for it yet. It still needs to be defined. That’s what we 
will do next. 

6.2 Symbolise Raster Data 
1. Open the Layer Properties dialog for the Population layer, which is now named 

Indonesian Population. 

2. Switch to the Style tab. This shows the current symbology settings, and as we’ve seen, 
they don’t give us much information on the layer. Let’s make sure the layer has data in 
it. 

3. Change the Render type to Singleband pseudocolor. Set colour to YlOrBr and change 
mode to Equal Interval with 6 Classes. Click Classify to show 6 classes. As shown 
below: 

note 

High resolution, contemporary data on human population distributions are a prerequisite for 
the accurate measurement of the impacts of population growth, for monitoring changes and 
for planning Interventions. The AsiaPop project was initiated in July 2011 with an aim of 
producing detailed and Freely-available population distribution maps for the whole of Asia. 
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4. Click OK. The raster should look like this: 

 

Good! This tell us that there is data in this layer. And by looking at it we can get an idea in 
Java Island, population number higher than other island in Indonesia. 

Let’s stop for a minute and understand what is happening here. Remember that an image is 
made up of pixels, individual cells that contain a value, which is usually a colour value. For 
example, if you zoom in very closely on a photograph you can see those individual pixels, 
like this: 
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The value of each cell is saved in the file. Imagine the file being saved something like this, 
where each square is a pixel: 

 

Of course the computer doesn’t understand words for colours. In fact the value of each cell 
would be a number, which the computer then associates with a certain colour. For our 
aerial image, this is already defined. Since it is a normal image, it knows to associate the 
numbers for each pixel in the file with the common colours that we see every day. But this 
new raster image is different, because the values of each pixel don’t represent colours, but 
rather altitude, and QGIS doesn’t know automatically how to display it. Hence it shows 
every pixel in the image as grey, even if the values in each pixel are different. When we 
change the symbology to Psuedocolor, we can see all the different pixel values shown with 
various colours. 
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It would be nice to represent our Indonesian Population layer as a greyscale spectrum, 
rather than a variety of bright colours. Next we will tell QGIS to symbolise the layer with 
colours in a spectrum, beginning at the lowest pixel value in the file and ending at the 
highest pixel value. In other words, if the pixel values looked like this: 

 

QGIS would create a spectrum equating numbers to colours like this: 

 

And render the image like this: 

 

To do that, let’s start to symbolise Indonesia Population: 
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1. Open the Layer Properties Again. 

2. Switch the render type back to Singleband gray (1). 

3. Check the box next to Min / max (2). 

4. Next to Contrast enhancement select Stretch to MinMax (3). 

5. Under Load min / max values, select Estimate (faster). 

6. Click the Load button: 

 

Notice how the custom Min and Max values have changed. The lowest pixel value in this 
image file is 0 and the highest is about 3024.93. But what are the minimum and maximum 
values that should be used? The current values are those that just gave us a grey rectangle. 
Instead, we should be using the minimum and maximum pixel values that are actually in 
the image. You can determine those values easily by loading the minimum and maximum 
values of the raster. 

1. Click OK. You should see the values of the raster properly displayed, with the darker 
colour representing small number of population in each pixel and the lighter one, high 
number of population in each pixel: 
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We’ve learned to do this the tricky way, but can we do it faster? Of course! Now that you 
understand what needs to be done, you’ll be glad to know that there’s a tool for doing all of 
this more easily. 

1. Remove Indonesian Population from the Layers panel, by right-clicking it and clicking 
Remove 

2. Load the raster image again, renaming it to Indonesian Population as before. It will be a 
grey rectangle again. 

3. Enable the tool you’ll need by enabling View → Toolbars → Raster These icons will 
appear in the interface: 

 

The button on the right will stretch the minimum and maximum values to give you the best 
contrast in the local area that you’re zoomed into. It’s useful for large datasets. The button 
on the left will stretch the minimum and maximum values to constant values across the 
whole image. 

4. Click the right button labelled (Stretch Histogram to Full Dataset). You’ll see the data is 
now correctly represented as before! 

6.3 Terrain Analysis 

Certain types of rasters allow you to gain more insight into the terrain that they represent. 
Digital Elevation Models (DEMs) are particularly useful in this regard. In this section we’ll 
do a little bit more with our DEM raster, in order to try to extract more information from it. 

6.3.1 Calculating a hillshade 

The DEM you have on your map right now does show you the elevation of the terrain, but it 
can sometimes seem a little abstract. It contains all the 3D elevation information about the 
terrain that you need, but it doesn’t really look 3-Dimensional. To get a better look at the 
terrain, it is possible to calculate a hillshade, which is a raster that maps the terrain using 
light and shadow to create a 3D-looking image. 

To work with DEMs, we will use the all-in-one DEM (Terrain models) analysis tool. 

1. Open the file named SRTM\_Merapi.tif, which is located in Merapi/SRTM/. 

2. When it appears in the Layer panel, rename it to DEM. 

3. Click Stretch Histogram to Full Dataset button. 

4. Go to Raster → Analysis → DEM (Terrain Models)… 
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5. In the dialog that appears, ensure that the input file is the DEM layer. 

6. Set the output file to hillshade.tif in the directory Merapi/SRTM/. 

 

7. Check the box next to Load into canvas when finished. 

 

8. Leave all the other option unchanged. 

9. Click OK to generate the hillshade. 

10. When the processing is complete. Click OK on the notification. 

11. Click Close in the dialog. 

There should now be a new layer called hillshade that looks like this: 
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This looks more Three-Dimensional, but can we improve on this? When you open DEM 
(Terrain Models) tools, you will notice in the Mode Options for hillshade there’re Azimuth 
of the light and Altitude of the light. 

Azimuth of the light defines in which direction the sun is, whereas 0° represent north, east 
is 90°, south is 180° and west is 270°. While Altitude of the light is the angle between the 
horizon and the centre of the sun’s disc. 

On its own, the hillshade looks like a plaster cast. It will look better if we can combine it 
with our more colourful DEM. We can do this by making the hillshade layer an overlay. 

6.3.2 Using a hillshade as an overlay 

Hillshade can provide very useful information about the sunlight at a given time of day. But 
it can also be used for aesthetic purposes, to make the map look better. The key to this is 
setting the hillshade to being mostly transparent. 

1. Change the symbology of the original DEM layer to use the Pseudocolor scheme. 

2. Click and drag the DEM layer beneath the hillshade layer in the Layers panel. 
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3. Ensure that Control rendering order is checked. 

 

4. Now we will make the hillshade layer somewhat transparent. Open its Layer 
Properties and go to the Transparency tab. 

5. Set the Global transparency to 50%: 

 

6. Click OK in the Layer Properties dialog. You should get a result similar to this: 
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Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the 
effect doesn’t seem strong enough to you, you can change the transparency of the hillshade 
layer; but of course, the brighter the hillshade becomes, the dimmer the colours behind it 
will be. You will need to find a balance that works for you. 
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Chapter 7: Using Map Composer 

 

 

 

 

Learning Objectives 

• Arrange map layout 

• Add new map 

• Add title to a map 

• Add graphic and numeric scales 

• Add grid to a map 

• Add an inset 

• Customise the content of the legend 

• Export a map to different formats (pdf, jpeg, svg) 

A map is a means to communicate information (as well as new ideas) tothe audience. We 
use symbology to convey the contents of our data so it can be easily understood. When we 
create a map layout, we go one step further - we present your map so that it becomes a 
means of information. 

No matter what media we plan to distribute your map by (whether it’s printed or sent over 
the internet), we must pay attention to how you compose your map elements in the layout. 
In this module we will discuss the presentation of printed maps, and create our very own. 

7.1 The Map Composer 

The QGIS Map Composer allows you to prepare it for printing. Apart from the map, you are 
able to add additional information such as images, labels, legends, and scalebars. 

• Let’s start with some data in the Sleman regency that has already been symbolised. 
Open the project named print_2_11.qgs in the qgis/ directory. 

 

This map shows some familiar layers from the previous module. We have the roads and 
vegetation of Sleman, along with the three impact zones from a Merapi eruption model. 
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Let’s see how we can use Map Composer to adjust the layout and prepare this map for 
printing. 

• Go to Project ‣  New Print Composer. Then, give an unique title name for your layout, 
for example: My Layout 1. Click OK, then a new window will load that looks like this: 

 

This is the window where you can compose the layout of a map that you want to print. The 
blank white area is your “canvas”.It is a model of the paper you are going to print out. You 
can put various elements onto this canvas, such as your map (obviously), a title, scalebar, 
and legend. These are elements commonly used on printed maps. 

Take a look at the right panel. In Composition tab, you change paper size, number of pages, 
and quality of output. 
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Take a look at the icons on the left of the window. We will use some of these as we lay our 
map out, so here’s an overview of what they do: 

 
Add New Map will add a map element. This is what we will use to add the map 
from our project into our print layout. It should be noted, however, that if we 
change the map in our QGIS project, it will not update the same map that we have 
added to our print composer, as we shall see later. 

 
Add Image allows us to add a picture. You can add a company or organisational 
logo, or simply display images from a particular location. You can also add an 
image of a compass (to point North). 

 
Add New Label is used for adding text to the layout, such as titles or other 
information. 

 
Add New Legend is for adding a legend, which will conform to the active layer in 
the QGIS window. 

 
Add New Scalebar is used to add a scale to the layout. 

 
Add Ellipse/Triangle/Rectangle is used to add one of these geometric shapes. 
For example, this might be used to indicate special areas or highlight things on 
the map. 

 
Add Arrow is used to draw an arrow on the map layout. 
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Select / Move Item allows us to choose and move the elements that are in the 
map layout. With this tool selected, you can right-click on an element to lock its 
position. 

7.2 Adding a New Map 
1. In the Print Composer window, click on the Add new map button. 

 

2. Next, click and drag your mouse across the canvas, creating a box. 
3. Your map layout should look similar to this when you are done: 

 

3. If you are not happy with the placement of your map, you can drag the corners to 
change the size, or drag the entire element around the canvas. 

4. Once you are happy set the scale of your map by going to the Item Properties tab on 
the right panel. 
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5. Edit the Scale and press Enter. You’ll see that the scale (zoom level) of the map 
element changes. A scale of about 200000 should be good for this project. 

6. Add a frame clicking the box next to Frame. Configure the frame color and border 
thickness. 

 

 

 

7.3 Adding a Title 

Now we’ve got the most important thing added to our map layout - the map! But let’s add 
some additional elements to make it more informative. 

note 

When you change the scale some parts of your map may become invisible. Click on the Move item 
contentbutton and drag the map so that it is all visible. 
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1. Let’s add a title to our map. Click on the Add new label button. 

 

2. Adjust the size of the element. We will edit the text and the text properties in the panel 
on the right. 

3. Click the Font button and change the text size to 18 and make it bold. Change the 
aligment to Center. Lastly, add the following text, or create your own: 

 

 

Your map layout should now look similar to this: 
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7.4 Adding a Scale Bar 

Let’s add a scale bar, so that anyone who looks at our map will have an idea what size area 
this map shows. 

1. Click on the Add scale bar button. 

 

2. Draw the new scalebar element on your map. A good location for it is in the lower left 
corner of your map layout. 

3. Next we need adjust the scalebar options. Since our project is in a PCS (Projected 
Coordinate System), our measurements are in meters. Enter the following values in 
the scalebar options: 
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This should result in a scalebar that looks like this: 

 

7.5 Creating a Grid 

Now let’s create a grid for our map. 

1. Choose the Select tool and click on the map. 

 

2. In the panel on the right you should see the word Grid. Click on it. 

3. Click on the box + and enter the following values: 
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4. Scrool down Item Properties dialog and Check the box next to Draw Coordinates and 
enter the following values: 

note 

We used coordinate reference systems with UTM (metre) on the project QGIS and all map layers. 

 



 

QGIS and InaSAFE for Disaster Management 
100 

 

5. Your map should now have a grid appear over it, which will look something like this: 
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Tips: 

1. Play around a little bit with coordinate format. You can change decimal degree as the 
coordinate fromat or change it into Degree Minute format (DD MM) or Degree Minute 
Second (DD MM SS). 

2. You can also adjust the coordinate placement. You can place the text inside or outside 
the frame, and make the orientation either vertical or horizontal. 

3. Change the font type and font size by clicking Font in the panel. 

7.6 Overview Inset 

Next, let’s add an inset that gives viewers of our map a little more information about what 
they are looking at. 

1. Click on the Map and go to Item tab. 

2. Check the box next to Map 0 item to lock the item. 

 

3. Minimize the Print Composer and go back into QGIS. 

4. Add the layer Indonesia.shp, which is located in qgis/peta_dunia. Cllick Zoom Full. 

 

The new layer will load. 

 

5. Return to the Map Composer and create a new map with the Add new map button. 
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6. Draw a small box on the right side of your map layout. 

7. The current view of your QGIS project will appear in the new map element (but notice 
that the old map element doesn’t change. It’s because we locked the Map 0 in Item tab). 
Add a frame for the inset, so it will look like this: 

 

7.7 Adding a Legend 

Now let’s add a legend so that viewers of our map will know what our symbology 
represents. 

1. Click on the Add legend button. 

 

2. Draw a box in the remaining empty space on your map layout. You will see a legend 
with symbologies shown in a list. 

3. In the panel on the right, click on Legend items. Uncheck Auto update and use the edit 
button to change the names on the legend. Use the + and - buttons to add or remove items 
from the legend. Choose which elements are important to include. 
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4. Our legend look like this: 

 

When you are finished, your map layout should look similiar to this: 
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7.8 Printing the Map 
1. Lastly, you can print your map. Simply click the Print button and follow the dialog. 

 

2. You may also save the map as PNG image. 

 

3. Additionally you can save the map as a PDF, which you can easily send over email or 
print later when you have a chance. 

 

 

  

note 

For save your map composer that you created, you can click on the Composer > Save Project.So if you open 
the project QGIS and you want use map composer that you saved, click on Project > Print Composer > My 
Layout 1. 
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Chapter 8 Using InaSAFE 

 

 

 

 

Learning Objectives 

• Understand Hazard, Exposure and Impact 

• Learn InaSAFE interface 

• Run InaSAFE for Infrastructure 

• Use InaSAFE OpenStreetMap downloader 

• Add keyword metadata 

• Set outline impact analysis 

• Run InaSAFE for Population 

• Use aggregation layer 

• Customize minimum needs 

• Print InaSAFE Result 

• Save Impact Result data into new layer 

InaSAFE provides overviews of potential disaster scenarios, of their outcomes, as well as 
map which can aid decision makers when disaster strikes. In this chapter we will learn 
about how to use InaSAFE along with other usefull features in InaSAFE for flood hazard 
scenario. If you interest to learn more about InaSAFE with other hazard beside flood, you 
go and learn in InaSAFE website. 

8.1 Hazards, Exposure and Impact 

Let’s begin by reviewing he inputs and outputs of InaSAFE – hazard; exposure; and 
impact. These terms are important for you to remember because the analysis process 
depend on these three things. 

Hazards (also called disasters) are what we call the data layers that describe the extent 
and magnitude of natural events (such as earthquakes, tsunamis, volcanic eruptions) that 
could potentially cause an event or series of events that threaten and disrupt the lives and 
livelihoods of people. 

In general, the hazards data we use in InaSAFE represents a single hazard scenario. A 
scenario means that the hazard: 

http://www.inasafe.org/
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• is at a particular location 

• has a measured intensity 

• has a measured duration 

• has a certain time frame 

Exposure data represents things that are at risk when faced with a potential hazard. This 
can be man-made features such as public buildings, houses, roads and bridges, or it can be 
so-called natural features, such as population, rice paddies and lakes. These exposed 
elements can be divided into various categories, including physical elements (houses, 
power lines), economic elements (agricultural land, access to employment), social elements 
(vulnerable groups, population count), and environmental elements (air, water, plants and 
animals). 

Impact is the result we get after InaSAFE processes the effect of the hazard data upon the 
exposure data. For example, if there is an earthquake model in Lembang, and we process it 
against building data in Bandung, our impact layer may show those houses that would be 
severely damaged, those somewhat damaged, and those mildly damaged. In other words, 
what goes in to InaSAFE are hazards and exposure. What comes out is impact. 

8.2 The InaSAFE Interface 

Before we run any scenarios, let’s take a closer look at the InaSAFE interface. 

1. First, make sure you’ve installed the InaSAFE plugins. Follow the plugin instructions in 
chapter 3 <ch3-basic-of-qgis>. Find and install the plugin called InaSAFE. 

2. Open a new project in QGIS. 

3. If the InaSAFE toolbar is not visible, right-click on the toolbars and make sure that 
InaSAFE plugin is checked. The toolbar looks like this: 

 

4. To show the InaSAFE panel, click on the Toggle InaSAFE dock button. 

 

 

note 

Just like QGIS toolbars, you can drag and drop the InaSAFE dock panel 

to change its position on the QGIS interface. You can pull it away as a separate window, or place it 
below the Layers panel. It’s convenient in its location on the right side of QGIS, so we will leave it 
there. 
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The InaSAFE panel consists of three parts: Questions, Results and Buttons. The questions 
are mixed in with dropdown boxes - this is where we establish our input data and define 
the scenario that we want InaSAFE to process. The purpose of InaSAFE is to make your 
impact analysis very simple and easy to do. The Questions section provides a simple way 
for you to formulate what you want to know. All questions are created in the following 
format: 

In the event of [hazard] how many [exposure] might [impact]? 

For example: "In the event of an earthquake how many buildings might be destroyed?" 

The Results section is filled in with information after InaSAFE is run, as we shall see. The 
buttons at the bottom allow us to run a scenario, print and access help. 
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8.3 Run InaSAFE for Infrastructure 

8.3.1 Adding Hazard Data 

We will learn about how to using InaSAFE to run impact scenario based on Infrastructure 
data. Before we started let start how to add hazard data. Hazards can be represented by 
vector layers or by raster layers. Remember that raster layers are like images with many 
pixels, and each pixel represents some data about an area on the ground. A raster that 
shows elevation, for example, will contain pixels with different values based on the altitude 
of the location. Similarly, a raster that represents a flood will contain the depth of the flood 
in every pixel in the raster. 

Let’s begin by adding our hazard layer to QGIS. It’s a raster model of flood in Jakarta. 

1. Click the Add Raster Layer button. 

 

2. Open flood_hkv_current.tif. This data is raster data (in .tif format) which represents 
the flood prone area. The layer will look like this: 

 

You will notice that the hazard drop-down box has been automatically filled in the InaSAFE 
panel. This is because the data file has already been prepared for us with keyword 
metadata (fancy words for settings) that tells InaSAFE whether it’s a hazard or exposure 
layer. When we add the exposure data, we will learn how to add these InaSAFE keywords 
ourselves. 
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8.3.2 Adding Exposure Data 

We can get the data from OpenStreetMap using OpenStreetMap Downloader. We will get 
any OpenStreetMap data based on the current map extent in QGIS. If your map extent 
displaying Indonesia, it will take a whole day according of our internet connection. It better 
to zoom in in specific location to minimize the bandwidth. Let’s learn how to use 
OpenStreetMap Downloader in QGIS to get OpenStreetMap data. 

1. Click on OpenStreetMap Downloader button. 

 

2. In the Feature Types you can choose all the OpenStreetMap data or specific data that 
you want download such as building polygons and Roads. Also you can download 
political boundaries and select level administration in your area such as RW Jakarta is 
level 8. 

3. Set you output directory to the destination you want by clicking “…” button on the right 
side. 

 

4. If you want to use some prefix, for example jakarta you can type in File name prefix 
area. 

5. We can download all the map canvas extent but it takes a long time. Otherwise if you 
want to download specific area, click on Drag on Map button and create a bounding 
box by dragging it to set download area 

6. Click on OK and wait until download finish. 
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7. You can hide the Roads by clicking the box next to Roads layer list. 

8.3.3 Adding Keyword Metadata 

In order for InaSAFE to know that our layers are hazard or exposure datasets, we need to 
assign keywords to the layers using the InaSAFE keyword tool. Let’s take a look at the 
keywords that have already been created on the hazard layer. 

1. Select the buildings layer in the Layers panel, and click on the Keywords Creation 
Wizard button. 

 

2. In the InaSAFE Keywords Creation Wizard window, we can follow the existing 
instructions step by step and change several keyword fields. 

 

3. Click OK. 

4. Select the Roads layer and open again the keyword editor. 

5. Notice that the layer now appears in the InaSAFE panel. 
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8.3.4 Set Outline Impact Analysis 

If you have a laptop with small ram, run InaSAFE for large area with so many data will 
takes a long time to finish. To solve that, we can set the analysis area to smaller area to 
make the analysis quicker. 

1. Select Toggle Scenario Outlines to showing analysis outline area. 

 

It will showing green box around in the map canvas. 

 

This green box is the analysis area that InaSAFE will calculate all the data inside the green 
box. 
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2. To change the analysis area, click Set analysis area button. 

 

3. Click Use intersections of hazard, exposure and this bounding box and click on Drag on 
map button and create a box to set analysis area. This will create blue box around map 
canvas. 

 

4. After that click OK. 

8.3.5 Impact Analysis 

Now our hazard and exposure data are set in the InaSAFE panel, because the appropriate 
keywords have been added to our layers. Note that if we were to add a second exposure 
layer to our project, we would be able to choose which exposure layer we wanted from the 
InaSAFE drop-down menu. The same applies to hazard layers. 

The third drop-down box is the impact function (“Might”). This concludes our question, and 
defines the function that InaSAFE will run behind the scenes. InaSAFE developers have 
written many of these functions to analyse all sorts of hazard and exposure layers. The 
function that is selected for us here will process the hazard and exposure layers spatially to 
determine how the exposure layer will “be flooded.” 

Click the Run button at the bottom to start the impact analysis. At the end of the process, 
the statistics will be displayed in the Results section, and a new layer will be added to the 
Layers panel that describes the result of the analysis. The map will distinguish between 
buildings that are affected and those that are not. 
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8.4 Run InaSAFE for Population 

In this section we will learn how to run impact analysis for population data with InaSAFE. 
We still use raster hazard data for flood in Jakarta but we will add another exposure data 
which is population from AsiaPop. 

8.4.1 Adding Exposure Data 

We already learn about how to symbolise this data in previous chapter (chapter 6), so if 
you think the colour of this AsiaPop’s data different than yours, you may need to symbolise 
it. 

1. Click Add Raster Layer button and add popmap10_all. 

2. Change the layer order like this: 
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3. You can hide the vector data such as roads and building to create more clear view in 
map canvas. 

8.4.2 Adding Keyword Data for Population 
1. Select the popmap10_all layer in the Layers panel, and click on the Keywords 

Creation Wizard button. 

 

2. In the Keywords Creation Wizard window choose exposure as category layer, we can 
follow the existing instructions step by step and change several keyword fields. The 
last step, you can fill the Title with people. 

 

3. Click OK. 

4. Notice that the layer now appears in the InaSAFE panel. 
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8.4.3 Using boundary as aggregation layer 

We can let InaSAFE to give impact result to us according whole area or divide it by 
administration boundary. It mean that the InaSAFE will provide impact analyst result into 
each administration area that we provide. This method will help us to know more specific 
result for each area, so we can know how many people that might be affected and how 
many logistic we should prepare for each administration area. To do this, we need to define 
aggregation layer first using Keyword Creation Wizard. 

1. Click Add Vector Layer button and add district_osm_jakarta.shp. 

2. Select the district_osm_jakarta.shp layer in the Layers panel, and click on the 
Keywords Creation Wizard button. 

3. In the Keywords Creation Wizard window choose aggregation as category layer. 

4. After that, you can follow the existing instructions step by step and change several 
keyword fields. The last step, you can give the Title with District Jakarta. 

 

8.4.4 Set Outline Analysis 

We already set the analysis area for calculating impact for building. This time we will set 
the analysis area for population data. 

1. Right click on flood_hkv_current_jakarta layer and click Zoom to Layer 

2. Select Toggle Scenario Outlines to showing analysis outline area. 

 

It will showing green box around in the map canvas. 
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This green box is the analysis area that InaSAFE will calculate all the data inside the green 
box. 

3. To change the analysis area, click Set analysis area button. 

 

• Click Drag on map button and create a box to set around the 
flood_hkv_current_jakarta area. This will create blue box around map canvas. 

 

• After that click OK. 

• We will run InaSAFE with Jakarta boundary as aggregation layer. To do this, simply 
change aggregate result by in InaSAFE panel into district boundary. 
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• Now click, Run to calculate impact analysis and wait for a moment. 

 

You will get impact result in the InaSAFE panel in the right side divided by 5 municipal in 
Jakarta. 
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8.4.5 Configure Minimum Needs 

When you scroll impact result from running InaSAFE scenario, you will notice that there 
are some statistic that show how many rice, drinking water, clean water, family kits and 
toilet for each municipals in Jakarta. It called minimum needs per week for each people 
evacuated. The purpose of this minimum needs is to provide quick method calculating 
support requirements (in terms of food, water, etc) for displaced persons. 

The minimum needs (by default) are based on ‘Perka 7/2008’ BNPB according to the 
following default formulas: 

• 400g rice per person per day (2.8 kg per week) 

• 2.5l drinking water per person per day (17.51 L per week) 

• 15l clean water per person per day (105 L per week) 

• One family kits per family per week (assumes five people per families which not 
specified in perka) 

• 20 people per toilet 

If you feel not satisfied with these configuration, you can define your custom minimum 
needs for your own area using Minimum Needs Configuration 

1. Click in Plugin → InaSAFE → Minimum Needs Configuration 

 

2. Minimum Needs Manager Window will appear. You can see in the Profile selection 
there are 3 profile that already defined, BNPB_en, Philippine Minimum Needs_en, 
BNPB_id, and Tanzania. 
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3. If you want to change the default minimum needs for each item in each profile, simply 
select an item that you want to change and click 

 

button in the right upper side of the window. 

4. You will enter Resource editor and from these editor, you can add or modify resource 
by fill each field that you think it’s important 

5. Click Save Resource if you already change the value from an item or click Discard 
Changes if you didn’t change anything. 

6. If you want to create your own custom minimum needs, click New in the bottom side 
of the window and you can start adding new item by click + button in the right upper 
side of the window to open Resource editor. 

7. Click Save after you add several item to your custom minimum needs. 

8.4.6 Run Impact Analyst with Modified Minimum Needs 

After you create your custom minimum needs you can run InaSAFE with your own 
minimum needs: 

1. Go to Plugins ‣  InaSAFE ‣  Minimum Needs Configuration 

2. In Minimum Needs Manager Window, select your custom profile in Profile selector. 
After that close the Minimum Needs Manager Window. 

3. Click Options… in InaSAFE Panel to open InaSAFE impact function configuration 

 

4. Click Minimum Needs tab to see if your own Custom Minimum Needs already set. 

5. Click Run to see the InaSAFE result with your custom minimum needs. 

8.5 Print InaSAFE Result 

The data displayed on the screen can be saved to a PDF file by clicking Print at the bottom 
of the InaSAFE panel. Before we print the InaSAFE result, we can improve our impact map 
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by editing the symbology in QGIS. Styles can be changed, other relevant layers can be 
added, and the layout can be changed using the Print Composer. 

1. Click on the InaSAFE result layer and click Print. 

2. A window will appear in which you can choose the extent to be printed. Choose 
Analysis extent if you want to print the entire map extent, or choose Current extent to 
print the analysis based on the current view of the map. 

3. You may also choose a custom print template inasafe-potrait-a4, landscape-a3, and 
portrait-a3. 

 

4. If you want to add additional information before printing, click Open Composer. 

5. To save it in PDF format for printing, click Open PDF. 

6. Choose your save location and click Save. 
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7. After you wait for a while, InaSAFE will create 2 pdf output, first one is the map based 
on your extent view and the second one is the statistics data. 

 

8.6 Save Your Results 

You can save the impact layer that InaSAFE created, and you can save the QGIS project to 
come back to it later, but note that the InaSAFE’s symbology style cannot be saved. It will 
show you only black and white layer and you need to symbolise again. 

8.6.1 Save your InaSAFE result style 

To get the style from your InaSAFE result, you need to save the InaSAFE result’s style first. 

1. Right click on Population which need evacuation, and go to Properties. 

2. Go to Style button on the bottom side the properties window and click Save Style …. 
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3. Save your symbology style as population_result_style and click Save button. 

 

4. To save the newly generated layer, right-click on it in the Layers panel. Click Save As … 

8.6.2 Save InaSAFE Result layer 

After you saved your InaSAFE result style now you can save your InaSAFE result layer and 
get the same style like the InaSAFE Result. 

1. Right click on Population which need evacuation, and go to Save As… 

2. Click on Browse button and select a name and location for the file. Click OK. 

3. Load your saved layer using Add Raster Layer button. 

4. You will see black and white layer in map extent. Open the properties of your saved 
layer to resolve this. 

5. Go to Style button on the bottom side the properties window and click Load Style… 
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6. Select your population_result_style and click Open button. 

7. Now your saved layer will have the same style with your temporary InaSAFE result 
layer. 

8. To use this style as default style you can click Save as Default under Style button. 

 

8.6.3 Save Project 
1. Click Save As button in toolbar. 
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2. Give a name to the project and put it in the directory where you want to save your 
work. Then click Save. 

 

Now you already learn about how to use InaSAFE from using InaSAFE Keyword Wizard to 
define keyword attribute, how to run InaSAFE with InaSAFE dock and Impact Function 
Wizard, how to modify minimum needs, and how to use OSM Downloader to download 
OpenStreetMap data directly. InaSAFE it’s really help use to know the impact of disaster 
and how we can create some plan if the disaster happen in real life. 
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